HanesBrands Europe
Consumer Privacy and Cookie Notice
HanesBrands is a social responsible manufacturer and marketer of leading everyday basic apparel under some
of the world’s strongest apparel brands. In Europe, HanesBrands owns and operates brands such as Bellinda,
Playtex, Wonderbra, DIM, Shock Absorber, Nur Die / Nur Der, and Lovable.
At HanesBrands, we respect our consumers (“visitor”, “you”, “your”) and recognize the importance of
protecting the privacy and security of your information. This Consumer Privacy and Cookie Notice (“Notice”)
provides an overview of the practices of HanesBrands and its affiliates, subsidiaries and associates
(“HanesBrands”, “we”, “our”, “us”) with respect to the collection, use and disclosure of personal data about
consumers. Personal data is any information that can identify you as an individual, such as your name and
contact information.
The term “consumer”, “your” and “you”, as used in this Notice, in intended to refer to HanesBrands consumers
and visitors to the Site. This Notice applies to information collected on this Site. If you have provided you
information through one of our US based Sites, you should consult the privacy policy provided on that Site as
these may be governed by different terms. This Notice does not apply to or govern:
•
•
•

Our HanesBrands Corporate Site; or
Our collection and use of information in connection with purchases made at our retail location s; or
Third party companies (including, without limitation, their websites, platforms, or applications) which
we do not own or control. These sites may have their own privacy notices and terms and conditions
that you should consult.

HanesBrands will seek to obtain your consent about the collection and use of your personal data where
required by applicable law. HanesBrands respects your decisions about the collection and use of your personal
data. You have the ability to revoke your consent at any time subject to applicable legal obligations, and you
may do so by clicking an "unsubscribe" link included in a communication or by contacting HanesBrands using
the contact information provided in this Notice.

Information collection
HanesBrands will collect information directly from you when you visit our website or use our other online
services. We may also collect information from other commercially available sources, where we are permitted
to do so by applicable law. Examples of the types of information we may collect from you includes:
•
•
•

Your name
Contact information such as your email address, postal address, telephone or mobile number
IP address

If you choose not to provide HanesBrands with your personal data, we may not be able to provide you with the
products or services that you have requested, or inform you about our products and offers from HanesBrands.
For more information, click here.

Information use
We use the information that you share with us to provide you with the products or services that you have
requested, to manage and improve our websites and the services we offer you, and to provide you with
information about other HanesBrands products or offers and those offers from our carefully selected business
partners.
For more information, click here.

Sharing your information
HanesBrands respects your privacy and, accordingly, only shares your personal data in a limited number of
circumstances. We may share your information with our trusted third parties who provide services on our
behalf (such as order fulfilment, or to send you information about products or services that may be of interest
to you). We may also share your information with our carefully selected business partners where we have your
consent to do so, and when we are required to do so, with government authorities to fulfil a legal obligation.
For more information, click here.

Protecting your information
HanesBrands has implemented administrative, physical, and technical measures to protect your information
from loss or unauthorized use or alteration. We will only keep your personal data for as long as necessary to
fulfill the purposes stated when collecting your information or as stated in this Notice, unless a longer
retention period is permitted or required by applicable law.
For more information, click here.

Your rights and how you can contact us
As permitted by applicable law, you have a right of access, rectification and deletion of information collected
about you, and the right to oppose, for legitimate reasons, the processing of this information. You can also
choose how HanesBrands communicates with you.
For more information, click here.

Cookies and other technologies
HanesBrands and our third party service providers will use a variety of technologies such as cookies and web
beacons, to better understand how our sites are used, personalize your experience, and deliver you with
advertising and online content tailored to your interests. You are able to accept or reject cookies through the
settings on your browser. By using our sites, you are providing your consent to our use of cookies in
accordance with this Notice. If you do not agree to our use of cookies, you should set your browser settings
accordingly.
For more information, click here.

Information Collection
In accordance with applicable law, HanesBrands will collect information about you in different ways, such as:
•
•
•

When you purchase a product or register for a competition, promotion, or newsletter; or
When you visit and use or Sites; or
Through third parties such as our business partners or commercial available sources

We will only collect the information needed to fulfill the purposes described to you when requesting this
information. If you choose not to provide certain information, we may not be able to provide you with the
products or services that you have requested, or inform you about our products and offers from HanesBrands.
As permitted by applicable law, the information that HanesBrands collects about you may be combined to help
improve your user experience and to enhance our products and services that you may be interested in.

Information you provide

HanesBrands will collect information from you when you visit the Site. For example, you may provide such
information when you buy a product, subscribe to various services such as email communications, post
reviews or other user-generated content, compile a "My Favorites" list or other product list, participate in
contests, respond to a survey, or communicate with customer service. Below are examples of the information
we may collect directly from you:
•
•
•
•
•
•

Name
Contact information such as your email address, postal address, and telephone or mobile number
Date of birth
Recording when you call our customer services team
Website account log-in details
Credit card or other payment information for purchases you make on the Site

When collecting personal data directly from you, those fields that are mandatory or optional will be clearly
indicated. If you do not wish to provide the information requested within mandatory fields, we will be unable
to process your request or order.

Information collected when you visit HanesBrands websites or use our other online services
HanesBrands and service providers acting on our behalf, use cookies, web beacons, Flash cookies (also known
as locally shared objects) and cookie technologies (collectively, “Cookies”) to receive and store certain types of
information whenever you view our promotions and advertisements, or when you use our Site. This
information may include the pages you visit on our Site, the web address from which you came, the type of
browser / device / hardware you are using, purchase information and checkout process information, search
terms and mobile geographic location, and the HanesBrands emails you open.
Further information about cookies and how you can control these, can be found here.

Information collected from other sources
As permitted by applicable law, HanesBrands may collect information about you from other sources, such as
our business partners and through commercially available sources. Examples of the information we may
collect from other sources include your name, contact information such as your email address or postal
address, your date of birth, consumer and market research data including purchase behavior, and any publicly
observed data or activities, such as blogs, videos, internet posting, and other user-generated content.
We also obtain information from third parties. For example, portions of the Site may include features or
widgets from various social media platforms, such as Facebook, Google Plus, Twitter, Pinterest, Instagram,
Tumblr and YouTube (each, a "Social Media Platform"), and we may enable you to register or log in to the Site
through a Social Media Platform. These features use Cookies to collect information about your IP address and
the pages on our Site that you have visited. Your interactions with those features are governed by the terms of
use and privacy policies of the companies that provide them.

Using your information
HanesBrands uses the information it collects about you and your use of our Site for a variety of reasons related
to our business operations and as set forth in this Notice, and we may combined information about you that
we collect online, in our stores, via mobile applications and from third party sources. Below are some
examples of how your information may be used.
Business communications: To communicate with you for business reasons with your consent or as permitted
by applicable law:
•

Responding to your requests (including, for example, to process an order including your payment for
any products you have purchased directly from us; to enter a sweepstake; post a testimonial,

•
•
•
•
•

•
•
•
•
•
•

photograph, comment, question, or other social sharing on our websites; receive product information
or catalogs through the post; or to enroll in our e-mail program);
Inviting you to participate in market research;
Providing any necessary notices to our visitors and notifying them about Site updates;
Sending e-mail offers, announcements, or newsletters to your e-mail address (these e-mails may
come from any of us at HanesBrands, including any HanesBrands affiliate);
Sending you offers, announcements, or newsletters through the mail, to the address you have chosen
to provide;
Contacting you (either by a traditional voice call or through a SMS or text message) on a residential or
mobile telephone number you have given us, to provide you with information about our products,
special offers, or promotions;
Contacting you using a telephone number you have provided, to complete a transaction you have
initiated with us;
Enabling users to register an account on the Site and to log in using their credentials from a Social
Media Platform;
Providing apps or interactive features of the Site, such as product reviews or marketing
communications and other information regarding our products, services and promotions;
Administering promotions, surveys and focus groups; and
Providing location-based services, including search results and other personalized content, through
use of location information obtained from your mobile device.
Provide you with advertising messages that are specifically tailored to your interests

Resource monitoring: To monitor usage of HanesBrands facilities and resources, and secure HanesBrands
premises, assets and information:
•
•
•

Understand how you use of the Site for internal research purposes and to enhance our product
messaging to you;
Improving the content, appearance and utility of the Site; and
Monitoring against theft and fraud.

Legal and regulatory compliance: Compliance, internal control evaluations and audits (conducted by
HanesBrands and external audit service providers), and, to the extent permitted in this Notice and by the
applicable law, providing assistance to law enforcement.

How your information may be shared
HanesBrands respects your privacy and, accordingly, shares personal data in a limited number of
circumstances.

Within HanesBrands
We may share your personal data within HanesBrands for marketing and other administrative purposes, in
accordance with applicable law. If you do not want to receive marketing information from HanesBrands, you
can use the unsubscribe link on each email communication we send you, or contact us on the information
provided below.

With our third party service providers
As a global organization, HanesBrands relies on third party service providers to perform various business
operations on our behalf. When sharing your personal data with our third party service providers, we will only
share the information they need to perform the services we request, and we require that they protect this
information and not use it for any other purpose. For example, we may use services provides for the following
purposes:
•

Fulfill your product requests including managing payment processing and shipping

•
•
•
•
•

Manage promotions or competitions
Host our sites and deliver our email or other communications
Analyze our data, sometimes along with data from other sources, to send you communications
Conduct market research and analyze data to improve our products, services and sites
Purchase or manage advertising space on other websites or applications, or through advertising
content (such as text, graphics, animations, videos, etc.) displayed on these sites or applicat ion, to
promote our business and current promotions. These advertising service providers may use Cookies to
collect non-identifiable information about your visits to the Site. Such non-identifiable information
does not include your name, address, e-mail address, or other information that can directly identify
you; but it may, in some cases, include your IP address. In addition to the information about your visits
to the Site, our service providers may also use the information about your visits to other websites to
target advertisements for products and services available from us.

In the event that HanesBrands or any of its affiliates are all or part acquired by a third party, your information
may be included in the transferred assets. Subject to the exceptions described below, HanesBrands does not
sell, rent, or make available to any third party whatsoever the personal data collected on the Site.

With our carefully selected business partners
HanesBrands often works with carefully selected business partners to offer joint promotions or products that
may be of interest to you. Where permitted by applicable law, we will combine information about you with
our business partners so that we can send promotional communications to you. For these programs, we will
make it clear when collecting your personal data that your information will be shared with our carefully
selected business partners and ask for your consent to do so, as required by applicable law.
If you would prefer not to receive these joint communications, you can opt out by following the instructions
provided in any such communication or through this Policy.

Other situations where your information may be shared
We may disclose your personal data, if we believe that doing so is necessary to protect and defend the right and
property of HanesBrands including enforcing our Terms and Conditions, or where we are required to do so by
law and / or government authorities.
We may share aggregated or anonymous information that does not identify you for HanesBrands business
purposes. For example, we may disclose the number of visitors to our websites. We may also share
aggregated or anonymous information with our business partners for their own business purposes, in
accordance with applicable law.

User generated content
Some HanesBrands sites allow users to submit their own content for contents, or to participate in blogs etc.
Any information you submit or post as user-generated content to HanesBrands websites will become publically
available information. We recommend that you to exercise caution when deciding to disclose any information in
such submissions or posts. HanesBrands cannot prevent others from using this information in a manner
that may violate this Notice, the law, or your personal privacy and safety. HanesBrands is not responsible for
the results of such postings.

Information Transfer
As a global organization, your information may be transferred within the HanesBrands organization located in
a country that is different in which you live, or to our trusted third parties based in other countries so that they
can process your information on our behalf. This may include the transfer of your information to the United
States. By using this website or providing information to HanesBrands, you consent to us transferring this
information in accordance with the terms of this Notice and as permitted by applicable data protection law.

HanesBrands will comply with applicable data protection laws when transferring your information to another
country, and has implemented procedures to protect your information in accordance with this Notice and
applicable law, regardless of where your information is transferred.

Protecting your information
HanesBrands has implemented administrative, physical, and technical measures to protect your information
from loss or unauthorized use or alteration. Your information is stored in a secured environment and access to
your information is restricted to prevent against unauthorized access, modification or misuse and permitted to
only those employees or third parties working on our behalf, on a need to know basis.
HanesBrands will retain your information for the period necessary to fulfill the purposes outlined in this Policy,
unless a longer period of retention is required or permitted by law.

Your rights and how you can contact us
HanesBrands respects your right to choose how we may contact you. If you would like to stop receiving
information from HanesBrands, you can follow the opt-out instructions provided in any communication
message you receive. HanesBrands will honor your request to stop receiving promotional messages from us,
in accordance with your opt-out instructions. However, we may continue to send you service-related
communications such as emails confirming purchases through our websites. We may also retain your
information for recording keeping purposes, for example, to make sure that we fulfill your request not to send
any particular type of messages.
As permitted by applicable law, you have a right of access, rectification and deletion of information collected
about you, and the right to oppose, for legitimate reasons, the processing of this information. To exercise
these rights, please write to:
Hanes Czech Republic, s.r.o., se sídlem K Třešňovce 247, 533 75 Dolní Ředice, zapsané v obchodním rejstříku
vedeném u Krajského soudu v Hradci Králové, pobočka Pardubice, v oddílu a vložce C 17620, IČO: 44264283

Cookies and other technologies
HanesBrands uses cookies and other online technologies to support our websites and online services, and to
help collect data. Cookies are small text files that can uniquely identify your device (e.g., computer, tablet,
smartphone), but can contain other information as well.
By using our sites, you are providing your consent to our use of cookies in accordance with this Notice.
Cookies we issue are used for the purposes described in this Notice, subject to your choices made via your
settings on your browser, which can be changed at any time. If you do not agree to our use of cookies, you
should set your browser settings accordingly. If you disables the cookies that we use, this is likely to impact
your user experience while using the website.
We may use cookies to adapt the offers and advertisements you see, based on data relating to the navigation
of your device on our site or within sites or services published by third parties on which we issue cookies. If you
have previously chosen to provide HanesBrands with your personal data, we may, subject to your choices,
combine navigation data on your device and process cookies we issue with your personal data to send you, for
example, personalized advertising messages that are specifically targeted, you may be interested personally.
At any time, you can request not to receive advertising tailored to the navigation data from your device, by
contacting us directly for free, or using the unsubscribe link included in any email correspondence you may
receive.

Cookies we issue
When you visit our Site, we will, subject to your choices made via your browser setting, installing cookies on
your devices that will allow us to recognize the browser on your device for the duration of the cookie session.
Cookies we issue are used for the following purposes, during your visit to our site:

•
•

•

•
•

Compile statistics such as volume of traffic and use of the various components of our Sites (including
the sections, content, and pages visited), to enhance the usability of our services
Adapt the layout of our website and display preferences (such as language, resolution, operating
system) of your device when you visit our Site, depending on the hardware and software of your
device.
Store information you provided through our websites forms (such as account registration) or to
products, services or information you selected on our website (such as the contents of your shopping
cart)
Allow you access to restricted or private areas on our site such as your account, through identifiers or
data that you have previously provided
To implement security measures, such as when you are asked to log in again to a content or service
after logged out after a certain period of time.

Cookies issued by third parties
In addition to those cookies set by HanesBrands when you visit our Site, third parties may also set cookies on
your device. This may be because they are providing a service to HanesBrands such as Site analytics or
maintenance, or because our Site contains content or advertising from those third parties. The issue and the
use of cookies by third parties are subject to the privacy policies of those third parties. We will inform you of
the purpose of cookies that we are aware of to allow you to make an informed choice about cookies.
Cookies issued by third parties may allow them, during the cookie session for the following purposes:
•
•
•

To count the number of times advertising content is displayed and delivered via our advertising
space
To identify the advertisements displayed and the number of users who clicked on each
advertisement to calculate statistics
To recognize your device upon subsequent browsing of any other site or service on which these
advertisers or third also emit these cookies and where appropriate, adapt these third party sites and
services or advertisements they display.

Interest-based advertising
Interest-based advertising uses information about you to provide relevant, targeted advertising likely to be of
interest to you. Click here for additional information on interest-based advertising. These advertising messages
will display on a HanesBrands site, or elsewhere on the Internet. You can limit your receipt of interest-based
ads on websites or in mobile applications by:
•
•

Deleting and declining cookies on your browser(s)
Opting out from receiving interest-based advertising on websites from companies participating in the
Digital Advertising Alliance (http://www.aboutads.info/choices/#completed) or the Network
Advertising Initiative (http://www.networkadvertising.org/choices/).

Some mobile device operating systems will allow you to limit the use of information to deliver interest-based
advertising in mobile applications. You can check the settings on your device for such options that are available
through your device’s operating system. Please note: if you choose opt-out of Hanesbrands' interest- based
advertising, you may continue to see or receive online advertising from us, but such ads may not be as relevant
to you.

How you can control cookies
There are several options available to help you to manage cookies on your device. At any time, you can
change your browser settings on your device that will likely change your conditions of access to certain
services that require the use of cookies. You can choose at any time to express and modify your wishes
regarding cookies, by the means described below.

Cookie consent
Saving a cookie on a device is dependent upon the choice of the user and the device browser they use to
exercise their choice. If you allow cookies on your device, these may be saved on your device, integrated into
the pages you view, and can be stored temporarily in a dedicated area on your device. These cookies will only
be readable by the issuer.
Rejecting cookies
If you reject cookies on your device, or if you delete previously stored cookies, you may not be able to benefit
from a number of features that require cookies to navigate some areas of our site, such as the default
language you have requested or the country from which your device is connected Internet. We are not liable
or responsible for the consequences related to impaired operation of our services due to the impossibility for
us to record or read the cookies needed to operate which you have rejected or deleted.
You can set your browser so that cookies are stored on your device, or rejected either systematically or by the
issuer. You can also set your browser so that you will need to accept or reject cookies, before the cookie is
likely to be stored in your device.
Each browser is different, and your ability to manage cookies is often described within the browser’s Help
menu. To help you, we have provided some additional guidance below. Please note that this will not prevent
advertisements from displaying on your device. It will only block technologies that tailor advertisements to
your navigation and your interests.

Web-browser

How to exercise your choice

Internet Explorer
TM

• Select the "Tools" menu (or "Tools"), then "Internet Options" (or "Internet Options").
• Click on the "Privacy" tab (or "Confidentiality")
• Select the desired level using the cursor or click on the "Advanced" button to customize your
cookie management.
• Select the "Tools"> "Preferences", then "Options" menu
• Click on the "Privacy"
• In "Keep Until", select "Use custom settings for history".
• Set the mode cookie management as appropriate you
• In the top menu, select the "Edit" menu
• From the dropdown menu, select "Preferences ..."
• Select the "Security" icon
• Make sure that in the "Accept Cookies" option "Always or Only from sites you navigate to" is
checked to allow cookies
• Select the "Options" menu> "Advanced Options"
• Click on "Content settings" in the "Privacy"
• Section "Cookies"
• Choose the "File"> "Preferences" menu
• Privacy

Firefox TM

Safari TM

Chrome TM

Opera TM

Our sites also use Google Analytics to better understand how you interact with our site. To opt out of Google
Analytics, visit:
https://support.google.com/analytics/answer/181881?hl=en
We also suggest that you visit the following sites for further guidance about how you can manage your
browser settings:
http://www.civicuk.com/cookie-law/browser-settings
http://www.cnil.fr/vos-droits/vos-traces/les-cookies/
http://www.allaboutcookies.org/manage-cookies/
http://www.aboutcookies.org/DEFAULT.ASPX?page=1

If several people use your device, or your device has multiple browsers, we cannot ensure that the services
and advertisements for your device correspond to your use of this device and not to that of another user of
this device. When sharing your device with other people it is your responsibility to configure your choices via
your browser settings regarding cookies.

Other technologies
In addition to cookies, we may use other technologies such as web beacons and JavaScript, to help us enable
features on our Site. Our Sites may also include plugins from social networks or other third parties, such as the
Facebook “Like” button, as permitted by applicable law.
With your consent or as permitted by applicable law, these plugins may send information to the party that
provided the plug in, even if you do not click on the plugin. The types of information that may be transmitted
include your IP address, information about your browser and device, and the address of the web page you are
visiting on our site.
Clicking, using, or loading plugins may also allow place, read, and transmit cookies on your device. These
cookies may contain a unique identifier the social network or third party assigns to you. The loading,
functionality and use of the plugins are governed by the privacy policy and terms and conditions of the party
that provided the plugin.

Changes to this Notice
We may update this Privacy Notice, by posting the updated version on our websites. We will give you
reasonable notice of any materials change, but recommend that you regularly visit this page to stay
information about how we may use the information collected about you.
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